Vocé ja tomou a decisao: dar o passo defi-
hitivo em direcao ao futuro, instalando o
Mac OS X. Sabia escolha, Gafanhoto. Mas,
mesmo com o visual agradavel e a estabili-
dade do sistema, vocé ainda nao esta total-
mente confortavel nesse novo ambiente?
Sente falta daquelas dicas espertas e gam-
biarras que quebravam o galho no sistema
classico? Bom, é para isso que estamos
aqui! Reunimos algumas das melhores
dicas para o OS X, desde as bem “babas”
até outras que necessitam de coragem e
algumas sessodes de linha de comando.
Divirta-se. E bem-vindo ao futuro!




Antes da versdo 10.1 do OS X, vocé 600 Torce Quit Appiications * 0 comando Force Quit (8)(Option)(Esc)) serve para
tinha que se conformar com a onipre- If an application doesn't respond for a while, desligar “na marra” aqueles programas que teimam
. select its name and click Force Quit. . .
senca daquele icone de HD no seu em travar quando mais se precisa deles.
desktop (ou fazer grandes gambiarras; : . * Alguns aplicativos rodam “escondidos” (como o
veja a edicdo 87). Agora isso acabou. # Grap Dock, por exemplo) e ndo aparecem na janela do
Um simples “copiar & colar” na janela & Intemat Explorer Force Quit. Para “matar” um desses programas, use
Show Info (8@ no Finder, igual ao ata- : :"‘L o programa ProcessViewer (que fica em /#pplications/
. , . review R . ,
Iho do Get Info no sistema classico) £ Ouanxress e Utilities), para ver uma lista tudo o que esta rodan-
resolve o problema. e m dgl. Duplo-clique o programa na lista e, n.a caixa de
Command + Dotion +Escapt. 1 didlogo que aparece, clique em Force Quit.
8o Miles Info
ece Progess Listing
Miles fing Show: [ All Procevian
®Se o Force Quit ou a dica do ProcessViewer nao e S Vo O
[ General Information |89 derem resultado, o jeito é dar logout ou restartar 0 | rrcesve ki
Mac. O comando Log Out (E[Shif@), no menu da e o W W
Kind: Volume -~ L . . Dock marisay  Rumsing an 19
WHEE=DeEvion maca, resolve a grande maioria dos pepinos, pois ATsere miew Woa 00 B
Created: 05 de fev de 2001, 14:25 desativa os processos do usuario (traduzindo: o tranifiae  maesd; lmer: 08 1=
Modified: 07 de nov de 2001, 11:47 . . . ~ SrssmiSarver maveny | Riiaring ar o5
Formats-Mac 05 Extendsd Aqua, os aplicativos e tudo o mais que ndo é co- Tetmina madca g 00 oaff
. . . N 2 TR Monirar marioay___Rusaing 15 [T
Capacity: 1,09 GB mandado diretamente pelo sistema operacional). E -
Available: 83,9 MB . L 42 processes, sumeheevery | TR vesunde
Used: 1,01 GB on disk (1.090.244.608 quase 0 mesmo que um restart, SO que mais rapldo. 2
bytes) *Se tudo isso ndo der certo, é caso de religar tudo T -
e comecar de novo. Mas nao se esqueca: salve tudo frreearioy st |
nos aplicativos ainda abertos que ndo travaram. t— b
Process Croup I T2
Comments: conbeds o
Finalmente o meu HD ndo tem mais cara
de hardware! \_ Y,
" — e
do, ao fazer a troca o icone do HD pode
simplesmente desaparecer. Nao se Vocé ja sabe que o atalho faz pular de um pro-
desespere: basta dar um Force Quit no grama para outro. Ainda mais util, porém, é o @,
Finder (@Option)(Esc), também o mesmo que pula de uma janela a outra do mesmo programa.
atalho do sistema classico). O novo Browsers de Web se beneficiam muito desse truque.
icone aparecera, belo e formoso. Como nem tudo é perfeito, justamente o Finder viola
esse padrdo: nele, @) serve para digitar um path
Y (endereco) para abrir. Ooops.
O  Applications (Mac 05 9} 006 [ Grabs (=1"
= = 23 items, 449,9 MB available
O This window only _ o Name
e Clabal Os Labels (Etiquetas) foram eliminados [¥ Bomba no Photoshop 6.tiff bombat
no Mac OS X e muita gente sente falta. bomba-quark 3.tiff bomba!
Para minimizar a perda, pode-se catego- bomba- quarkutf bomtial
Show Columns: rizar os arquivos de outra maneira: B3 quark-bomba.tiff bombat
" , h do d . I - g omniweb-do...d com pau.tiff como?
E Date Modified | Escolha OdmO 0 dé visualizacao por 8 icone-mandala Emilio.tiff fora de lugar
ista no Finder. ¥ 011002 widesereen hehehehe
) Date Created 2 Abra o painel View (BW). [ caixa de open gigante.tiff hehehet
! Size 3 Em Show Columns, ative a opcio Finder-13 colunas.tiff hehehehe
® Kind Camments. B s Mehdhohe
M Version 4 Abra o Show Info (@) e classifique > G Crabs-Miles ks abes
— 0s arquivos um a um, usando comen- g 010927-2.tiff rever
tarios curtos do tipo “Pronto”, “Em Anda- 011003.tiff rever
mento”, nimeros ou o0 que mais quiser. % 011009.tiff rever
E Use relative dates § Os comentarios podem ser sorteados COpy- 7 GRAIE i)
. L = copy-22 gb-1.uff rever
[[] Calculate all sizes na janela por ordem alfanumérica, exa- B capy-72 gh-? Hff rever
tamente como se fazia com os Labels. B2 bomba do Omnl.tiff ridiculo
= B Arraste o titulo da coluna Comments pau de DVD Player ridiculo
A ‘l, ﬁ para colocé-la onde seja mais conforta- paiLde Newwark Time.plet Hdieul
Icon Size: vel de ler. pau de unmount do QUE3.tiff ridicule
@ e SpamDevil.tiff site
i= Falnl s
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€ Varias janelas ou uma s6? ) € Do Desktop para o mundo’)

*No Mac =) ® Quando vocé esta numa janela do Fin-
860 Finder Preferences OS X, por —— der no modo de lista, teclar leva a
default, ao —3
Show these items on the Desktop: abrir-se uma nova janela
EHard S o conteldo aparece dentro
Ekemnvable media (such as CDs) dela’mesma. Quem prefere
0 método antigo de abrir
# Connected servers uma janela por pasta e esta
New Finder Window shows: com a versdo 10.1 pode esco-
® Home Ilher esse método nas preferén-

cias do Finder, checando as
opcoes indicadas a esquerda.
Clicar no botdo branco do
lado direito das janelas do

O Computer

EAlways open folders in a new window

¥ Keep a window's view the same when Finder oculta a barra de ferra- um diretério acima e a um abaixo.
opening other folders in the window mentas e também faz abrir A mesma ldgica vale para o Desktop;

as pastas duplo-clicadas em mesmo sem uma janela do Finder '

[ Show warning before emptying the Trash novas janelas. aberta, esses atalhos funcionam.
= *Duplo-clicar para abrir com faz abrir uma janela com o seu

& Always show file extensions pressionado sempre faz abrir a diretério Home e abre uma janela

pasta em outra janela, nao com o préprio Desktop.

importando as preferéncias ® 0 atalho “oficial” para abrir a pasta

nem o modo de visualizacdo. Home é (&)(Option)(H).

J

€ Login como root pelo Aqua )

*Se vocé tem varios usuarios na sua maquina e precisa “logar’” como
root no startup, vai perceber que o root é omitido por default naque-
la linda janela com os icones de todo mundo.

Para poder entrar como root, abra o modulo Login do System
Preferences, selecione a aba Login Window e escolha “Show ‘Other
User’ in list for network users”. O resultado é que a janela de login
vem com um botao a mais, chamado “Other” (1); clicando-se nesse
botdo, surgem os campos para digitar nome e senha no braco (2).
*Qutro método: mude a opcao “Display Login Window as” (“Mostre a
Janela de Login como”) para “Name and password entry fields”
(“Campos para digitar nome e senha”). Com isso, a tela de botdes é
substituida por outra tela com campos de digitacdo (3) e todo
mundo passa a ter sempre que digitar o proprio nome em vez de
curtir a moleza de clicar num botdozinho decorado.

Reslarl Shut Duwn

Password

qes

Go Back Restart  Shut Down




e— = € Cadé o Chooser? )

Se 0 seu Mac OS X esta se comportando

e maneira muito estranha, antes de 50 Printer List *No Mac ele ndo existe mais. Para
d to estranh tes d 5] No Mac OS X el t P
partir para os “finalmentes” (reformatar e 2 selecionar ou configurar uma impresso-
o disco, reinstalar o sistema etc.) va ao TR : ra, va pelo utilitario Print Center (Centro
N R Local ApplaTalk Zone 3 - . . .
System Preferences, mddulo Users, crie =T de Impressao), que fica em /applications,
o | gm cqips , . . s
um novo usuario e cheque se por ele os 13 P I LItilities, ou pela propria caixa de didlogo
roblemas continuam. As vezes, a i . ao po
bl t A de Print do programa. O OS X ndo pde
encrenca pode estar nas preferéncias e r icones de impressoras no desktop.
permissdes das pastas do usuario, e ndo . Programas no ambiente Classic conti-
no sistema em si. — Printer Model: [ Auto Sefect.. —= nuam imprimindo do mesmo jeito de
lZR) antes, pela impressora selecionada no

Chooser do Mac OS 9.

J

Connect to Server

Choose a server from the list, or enter a server address

( \ A [ AppleTalk BIG]
_ Para acessar outros computadores pela rede, R 8 e

va ao menu Go » Connect to Server (2)(K]) no B8 ocal Newwark -+ g gl
. . L . - L o
*Nos programas TextEdit, Grab ou Pre- Finder e dai em diante o processo de conexao
view, se vocé arrastar para fora o mini- é 0 mesmo do Chooser, apenas mais bonito.

icone que fica ao lado do nome do ar-
quivo aberto na barra de titulo,
criard um atalho onde o soltar. !

4 iems

Igl Address: | ]

Bigouse 4 ()
e —_—
IBM \ -
A Briel Limux Glossary Tor Windews Users (

um menu listando o path (endereco) do

arquivo; soltando o botdo do mouse *Nao se confunda com a aparente redundancia de pastas e arquivos no Mac OS X. Se a sua
sobre um dos nomes de pastas, ela se maquina foi configurada para ter varios usuarios, quando for instalar um aplicativo, faca-o
abre no Finder. como administrador, para sempre colocar os softwares nas pastas /#pplications e sLibrary.
e — Nessas pastas, o software fica disponivel para qualquer usuario. Cada usuario tem suas
2 Downloads proprias pastas ~/#pplications (opcional) .
weantie e ~/Library, para os itens que sdo usa- @ Applications
i marioav . . . .
Ol Users BM dos s6 por ele e mais ninguém. e
p— n‘_f'“‘w B 0 “administrador” é o [ﬁ Library
mesmo usuario que vocé == —
*Essas dicas funcionam nos programas criou quando instalou o E HE=> [ﬁ Systenis @ Hbrary
criados no ambiente Cocoa, no Finder e OS X. Nao o confunda com o = i = - ﬁ —
até em alguns aplicativos que s6 rodam root, que é o super-usuario com Sete—m Hlarech ppiicatians
no Classic. plenos poderes sobre o sistema. =
Library
= i = € Cadé o preview? )
18 items, 125,7 MB avallable B .
[® Picture Ltiff O O telaconfusa2.png Info

@ Picture 2.1iff *Muitos arquivos (capturas da tela, algumas imagens
¥ Picture 3.uff - tataonfusa2.pig baixadas da Int t etc.) na t i
B Picture 4.2 ? o + aixadas da Internet etc.) nao mostram preview no

i Freview =

& picture 5.1iff : Finder. Curiosamente, o preview aparece no Show Info

%::::“"’ ?::g o (8®D) para o arquivo. Entdo, o negdcio é usar o Show
ure /.| . N . . .

) Picture 8.1iff Info para pré-visualizar as imagens teimosas.

_. Mame: telaconfusa2.png
Kind: Portable Network
Craphics Image

ePara que as imagens salvas pelo Photoshop 6 tenham
previews melhores no Mac OS X 10.1, va as preferén-
Size: 560 KB cias do programa (#K) e, na secdo Saving Files ((2),
adthad: oo —— deixe o seguinte ajuste: Image Previews - Always Save
- “lcon” ativo, “Full Size” e os dois “Thumbnails” inati-
vos. Com isso, o comportamento dos arquivos é o
seguinte: preview grande no Finder para PSDs até um
certo tamanho (em torno de 2,5 MB); a partir dai, s6
mesmo o icone antigo pixelado - mas um preview de
alta qualidade sempre pode ser visto no Show Info.

L4 el et 1




Grande Listao Supremo dos
Comandos do Mac OS X

Para xerocar, recortar e colar no seu monitor

Atalhos gerais

@)(Shifd(3) - Tira foto da tela (o arquivo é salvo como TIFF, no seu desktop)

@)(shifd(@) - Tira foto de selecdo da tela (idem)

(E12) - Ejeta disco (para teclados sem a tecla [Eject])

@-clicar - Move item (pasta ou arquivo) de um disco para outro; copia e em seguida apaga o
original

e - Copia e cola arquivos e pastas
[@)Option)(d) - Abre a pasta Applications

@ Option)H) - Abre a pasta Home l
- Esvazia o Lixo

- Abre a janela Computer
@)(Cption)(D - Abre o iDisk

Arrastar botao do pé de coluna do Finder (acima) - Redimensiona todas as colunas juntas
(Option)-arrastar botdao do pé de coluna - Redimensiona apenas a coluna do botao arrastado
- Navega pelos discos no modo de colunas

no startup - Mostra as mensagens de boot no modo Verbose, com todos

os comandos de Unix desfilando na tela

@® no startup - Carrega o sistema no modo single user, direto no console Unix
[Option)-clicar no botdo verde de maximizar - Abre a janela em tela cheia na altura.

A largura depende do programa. Nao funciona no Finder

No Dock

- Pula para o préximo programa ativo, pela ordem do Dock, da esquerda

para a direita

- Pula para o proximo programa ativo, na ordem inversa

- Esconde Toolbar (Barra de Ferramentas)

[Option)-clicar no icone de um programa no Dock - Muda para esse programa

e oculta aquele em que vocé estava antes

(Gption)-clicar e segurar no icone de um programa no Dock - O comando Quit do

menu do Dock muda para Force Quit

[Option)-arrastar arquivo para o Dock - Forca o arquivo a ser aberto por um

programa que nao esta associado a ele

(Control)-clicar no topo da linha diviséria do Dock — Menu contextual do Dock
(Option)-arrastar a linha diviséria do Dock na vertical - Redimensiona o Dock para tamanhos
especificos de icones (16x16, 32x32, 48x48 e 64x64 e 128x128)

(Shifg-arrastar a linha diviséria do Dock na horizontal - Move o Dock para as laterais da tela
(pode ser necessario reduzir um pouco o tamanho do Dock antes de tentar esse truque)

y,

| N
€ Janelas empilhadas )

No Mac OS X, as janelas do programa

' | correntemente em uso n3o vém necessa-
riamente a frente das demais. Isso pode

d | . ~ . .

{ E DEEktﬂp f ser incdmodo ao ir para o Finder ou

1 Desktop Info
1 Publie

] Documents
] Shared

outro programa com varias janelas e
entdo ter que “desenterrar’” uma delas
pelo menu Window. Uma maneira mais
facil é ir ao icone do programa no Dock
e escolher a janela diretamente no menu
contextual (clique e segure ou clique no
icone com pressionado). Esse
método funciona com o Finder e com
qualquer programa Cocoa ou Carbon,
mas nao com os aplicativos classicos.

Para criar um arquivo PDF (compativel
com Mac OS classico e PCs) a partir de
qualquer programa nativo para o Mac
OS X (processador de texto, editor de
imagem etc.), va ao menu File » Print e
na caixa de dialogo clique no botao
Preview. O sistema vai mandar abrir a
pagina no programa Preview (Pré-
Visualizacao).

008 % Read Me.rtfd i
Printar- | PET B
St sengs (St
[Copiesapages T8
I : Capies: W collares
&
i

Pages: @ AN 8
O Fram: [1 Joe [1 | —§

2 = - D |

854 (32:biticony with B-Bit icons|, Mac O5 X {128 x 128 icons in Jems
Hiox), Windows and

Windows XP [ ico fles). and Mac 05 X Server (48 x

Al icons in M Sles).

Neste, va para File » Save As (8)(Shift)(S))

e clique em Save As PDF. Pronto!

& Preview m Edit Display Window
Open... wo |

Open Recent »
Close RW
Save As... OXS
Export...

Page Setup... O-%P
Print... #P

Para copiar os favoritos e o historico do
Explorer do Mac OS 9 para a versao do
X, basta mover a pasta #Systern Folders
Preferences/Explorer para a pasta
AUszers/[voc]fLibrary/Preferences.

Vocé tem uma daquelas velhas placas de
Ethernet com chips da Realtek e achou
que tinha perdido definitivamente seu
uso no Mac OS X? Engano. A Realtek lan-
cou drivers que funcionam com qual-
quer placa baratinha que utilize o chip
rtl8139c. Para saber se sua placa possui
o chip correto, veja os drivers para
Linux para o modelo de sua placa. Os
drivers podem ser encontrados no site
whwtw versiontracker.com.

N




& New Mailbox

Enter new mailbox name to be created as a child of
2 in t "ITools e

New mailbox name: | Macmania/Lista |

You create nested folders by entering a name with slashes in
it. For example. ‘Personal/fun® creates a folder named Fun

inside of a folder called Personal.

*Mais um truque com pastas: ndo importa
para qual lado vocé arrastar uma mensagem
(esquerdo ou direito), a gaveta com as pas-
tas sempre abre automaticamente na dire-
cao escolhida. Assim, para inverter o lado
da gaveta é sé arrastar a mensagem na
direcao oposta.

A partir do OS X 10.1, é possivel criar pas-
tas dentro de pastas no Mail. Para isso, digi-
te nomedapasta‘nomedasubpasta na janela do
comando Mailbox » New Mailbox. (Se vocé
errar o local, vai acabar criando duas pastas
de uma vez, porém.)

*Qutro jeito é criar as pastas e arrasta-las
para baixo umas das outras. As listas e sub-
listas sempre sdo automaticamente arran-
jadas em ordem alfabética.
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*As bombas bravas (aquelas que
travam tudo e tiram a gente do
sério) no Mac OS X tém o sugesti-
vo nome de kernel panic. Uma
coisa dessas sé acontece quando
pifa alguma coisa diretamente
administrada pelo kernel, o “cora-

cao” do sistema - usualmente,
paus de hardware, mas um ou
outro software também pode
causar o pau. Calma: esse tipo de

erro é extremamente raro. O resultado é meio assustador: vocé vai ver uma porcao de
mensagens incompreensiveis em texto branco sobre preto, emporcalhando sua linda inter-
face Aqua. Ai, a Unica coisa a fazer é apertar o botdo de restart.

Para evitar esse problema, esteja sempre com o sistema atualizado e verifique se o progra-
ma suspeito de ter causado a bomba (no caso de haver um) ja tem um update. Um bom

site para procurar atualizacdes é o VersionTracker («

cersiontracker.com).

Qutras vezes, a interface trava; o mouse ainda funciona, mas tudo parece congelado. E a
memoria virtual da sua maquina que “entupiu” momentaneamente. Espere até o sistema
voltar a responder (coisa de 15 segundos ou menos) e a seguir dé Quit nos programas
abertos que nao estdo fazendo nada. E prepare a verba para comprar mais RAM (aproveite,

esta barata!) se essa ocorréncia for comum.

Para ter uma Unica pasta Desktop no Mac
0S 9 e no OS X, abra o Terminal e dé su
(ou “logue” como root e entdo abra o
Terminal) e dé os seguintes comandos:
rm -R Desktop - Apaga o Desktop Folder
do usuario ativo (‘Users/[vocél/Desktop)

In -5 ‘/Desktop Folder' /Users/[vocg]l/Desktop
(cria um link (alias de Unix) do Desktop
Folder do Mac OS 9 no lugar do Desktop
do Mac OS X)

Se vocé fizer isso para outros usuarios,
eles compartilharao o mesmo Desktop.
O truque também pode ser usado para
compartilhar a pasta Public ou outras.
Obviamente, ndo o faca com as pastas
Library, Documents e Applications

(se houver; vide dica 11) dos usuarios.

J

~

No Internet Explorer 5.1, além
de poder arrastar a URL da pa-

~

gina para a barra de ferramen-
tas para criar um atalho, vocé
tambem pode arrastar uma ima-
gem qualquer (o logo de um

@ B

vorites

I

Goo

B] Go to Google Home

site, por exemplo) para servir
de link. Para tirar o atalho de

i Tech Mews S5 Fotograha S5 Botdnica

o

14, (Control)-clique nele e peca

Delete no menu contextual.

N

Para usar outro idioma além do portu-
gués ou inglés no Mac OS X - tem até
chinés e japonés disponiveis sem a ne-
cessidade de nenhuma instalacao adicio-
nal -, abra o System Preferences (Prefe-
réncias do Sistema), modulo Internatio-
nal, e arraste o nome da lingua desejada
para o topo da lista.

Dé Logout e Login de volta e pronto. Os
programas que tiverem suporte ao
idioma listado no topo mudarao; os

que nao tiverem ficardo na primeira
opcao disponivel abaixo dele.
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Nado use nenhum utilitario de disco
“classico” como o Norton Disk Doctor ou
o Hard Disk Tools, a ndo ser que esteja
especificado que a versao é compativel
com o Mac OS X. As ver-

sOes antigas podem aci-

dentalmente apagar

dados importantes.

Depois nado diga que

nao avisamos!




E uma funcdo indtil, mas divertida. D4 para usar seu DVD como imagem de fundo.
Primeiro, abra o tocador de DVD e tire uma foto da tela em preto com o Snapz Pro - o
Unico programa no Mac que consegue fotografar DVDs rodando. A tela vai ficar toda
preta. Arraste a tela salva para o well do modulo Desktop do System Preferences. Depois,
toque um DVD e esconda a janela ((Control(V)). Se quiser, selecione Video » Maximize Screen
e depois esconda a janela (mas ndo pode selecionar Full Screen - tela cheia). Pronto: filmi-
nho passando por tras dos icones.

\

Cansado daqueles icones em preto e branco na sua barra de menus (AirPort, monitores,
som etc.)? Para dar um pouco mais de cor a barra, abra e edite os proprios icones. Aqui
vai um exemplo: o icone do AirPort fica em /Systemn/Library/CoreServices/Meny Extras’
#irPort menusContents/Resourcess (é preciso usar o menu contextual no arquivo &irportreny e
o ~+ escolher Show Package

|i| (100%) o) \f Wed 5:58 PM i ﬁ Contents para abrir o
pacote e encontrar a
pasta Resources).
Utilizando o Photoshop ou outro programa de edicao de imagens, mude os icones (sem
alterar sua dimensao em pixels) e salve-os como PSD (para que eles continuem com o
recorte de transparéncia). Depois, abra os icones no Preview e converta-os para TIFF - é
preciso fazer isso “logado” como root. Coloque os arquivos mudados de volta as pastas.
Dé logout e login e e veja o resultado.

No programa Mail, volta e meia vocé
recebe mensagens com os acentos
embaralhados, como neste exemplo:

p

\.

Boato de virus E um protesto contra a pirataria
Mensagem diz que arquivos de MP3 contim viru

O 'ltimo boato de virus que circula na Internet o
enganar pessoas gue n,o entendem do assunto,
contra a pirataria de m ' sica na Web.

A mensagem diz que cerca de 500 arquivos de
baixados nos “ltimos & meses por usu - rios de f
compartilhamento, como Napster e Gnutella, co
chamado MusicPanel, que causar- danos aos m

J

Para conserta-los, va ao menu
Format » Text Encodings e escolha
Western (ISO Latin 1).

p

Boato de wirus & um protesto contra a pirataria
Mensagem diz que arquivos de MP3 conté&m wir

O ultimo boato de virus que circula na Internet
enganar pessoas gue nao entendem do assunto
contra a pirataria de misica na Web.

A mensagem diz que cerca de 500 arquivos de
baixados nos Gltimos & meses por usudrios de
compartilhamento, como Napster e Gnutella, col
chamado MusicPanel, que causara danos ans mi

J

J

J
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Se vocé era daqueles que adoravam ver os Stickies (ou qualquer outro programa) abrir Os dias de isolamento entre Macs e PCs
sozinho toda vez que o seu Mac ligava, va ao System Preferences e selecione Login. Na acabaram! No OS X 10.1 vocé pode aces-
aba Login Items, use o botdao Add (Adicionar) para incluir os programas que vocé quer sar os discos de computadores Wintel
abrir automaticamente quando o Mac ligar. E possivel também escolher documentos, pas- pela rede local usando o protocolo SMB
tas e outras coisas. Se vocé clicar na caixa de opcdo ao lado do nome, o programa ira (que é o padrao no Windows). S6 tem um
abrir em segundo plano (background). sendo: os servidores SMB nao aparecem
O Unico sendo do Login Items é que o Mac pode ficar extremamente lerdo quando esta listados na janela de Go » Connect to
abrindo uma porcdo de programas ao mesmo tempo, mas ele volta ao normal assim que Server do Finder.
acaba o processo. TR
Chnwse a server fram the e, ar snier a server address
00°C =) OO I —
] O -IE&Q 9@ e [HES
: B8 Local Network * | 8@ Calo-Ruby
Show All 5 Date & Time Displays Screen Saver Dock Sound Metwork Startup Disk Classic g;:::;:‘aan
8 Mario-G4
& Miranda-PBook G3
B meranguim
& Redagio-5500
These items will open automatically when you log in: @ Shima-7600
THide Titem [Kind =
] W Terminal Application Adnts [ o)
- o (o €
———————————————————————
Vocé tem que digitar no campo
Address o endereco completo:
smb./ A servidor fpasta_compartilhada/
Drag items to specify the order in which they open. Se tudo correr bem, vocé vera uma tela
To hide an application when you log in, click its Hide checkbox. para preencher com o nome do seu
 Remove * { Add.. ) workgroup do Windows, nome de
usudrio e senha. Ai é so clicar no disco
pecezista e correr pro abraco. Sé nao
R compartilhe duas pastas simultanea-
Y mente, pois isso pode dar kernel panic.
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O Disk Utility do Mac OS X (que fica em /épplications/Utilitiez) absorveu as qualidades do
antigo Disk First Aid e outras mais, mas uma delas ficou de fora: a capacidade de conser-
tar o préprio HD (ou particao) de partida do OS X. Felizmente, o Unix por baixo do OS X
contém sua propria ferramenta de disco. Se vocé acha que o HD esta com pau, faca isto:
1 Restarte e segure as teclas para entrar em single user mode (isto é, direto na linha
de comando e sem carregar nada além do kernel - algo vagamente semelhante a iniciar o
sistema classico sem as extensoes).

standord Uimes] icing quonton is 18888 us

Keep In Dock
Show In Finder
Force Quit

Recording startup extensions.
Copyright (c) 1982, 1966, 1969, 1991, 1993
The Regents of the Unlveraity of Callfernio. Al rlghts reserved.

weing 655 buffer heoders ond 327 cluster 10 buffer heoders
x (eulle ] 38

LRz 1ATRGRR]
(LA
up and running
3 up and running

mit
input_threod 1613dch
T0KieBS0nit
Fron path: */pcief 2886808 /pc | -be | dgeed f ‘\wach_kernel®, Ualting on <dict 10="8"><key>10Pathiatehs koyr<string 10="1">100eviceTren: /pclel
2008088/ | -br | dgwed,woc- | oeT//ot o-4e] (806w
Gat boot device = 105ervice:/Core99PE/peie 2886808, Rpp| eflochiscPC] fpc | -br | dgeed/ 10PCI2PC1Br I dge/woc- |07/ Keylarga// ot a4 T80/ Koyl argoRTA/ATRDey | cetiube | /TORTAD I
orogeleyice/ 106 | ock 5t oronele |ver QUAKTUN FIREBALL ct28 38 Hedia/10Rpp | ePart It lonSchess/unt [t led 2

38, wojor 14, wimr 5

oot device ia mounled read-nnly
It you mond o soke modifical ions to files,

run ‘fabinfack -y' | and then */shinfsount -us /'
ACTRTIVRTE Y |

2 Quando surgir o prompt (é esse * WUENN Wy no fim das mensagens), digite:

fazk -y (@ opcdo -u serve para responder “sim”
automaticamente a todas as perguntas feitas As\w \weth \e X fsck —y
** fdev/rdiskls
pelo programa). ** Koot file system
J Depois de alguns minutos, o disco estara veri- [ HES Flus voluse.
. o E 3 Dverflom file.
ficado e consertado. Para voltar ao uso normal, ., Checking Extents Quertlow file

ng Catalog file.
digite reboot e pronto. ** CheckIng sultl-1inked flles.

A dica s6 funciona nos modelos de Macs mais

** [hecking Catalog hlerarchy.
** CheckIng voluse bltmap.

Q—W modernos (os sem ADB e SCSI embutidos). Se *+ Clecking vuluse infurmation.
Y ] (3

nao rolar, use o velho método de rodar o Disk
Nas maquinas que tém o teclado Pro First Aid pelo Mac OS 9.
(aquele com teclas de volume) ou nos
portateis recentes, se vocé quiser abrir o
System Preferences (Preferéncias do
Sistema) e aumentar ou abaixar o volu-
me ao mesmo tempo, basta pressionar
uma tecla de de volume com a tecla W
[Option) apertada. O sistema abre as
preferéncias e também executa a
funcao de modificar o volume.

Yaw \weth w X

28086 " console.log

Hov 7 19:23:12 localhost lockupd[218]: DNSAgent: dns_fqdn_guery_scrver - query
failed for 208.240.5.2

Now 7 19:23:47 localhost lookupd[215]: DNSAgent: dns send QUETY Server - timeout
Tor 7AR.7AR.7 .7
\I\I | B Mowv 7 19:23:E7 localhost lost meszoge repeated 2 times

] Moy 7 19:23:57 localhost lookupd[2187: DNSAgent: dns_fodn_guery_server - query
! failed for 200.200.2.2

\-/ Mow 7 19:24:02 locolhost lookupd[213]: ONSAgent: dns send QUETY SErver - Timeout

for 7AR.746.5.7 m

How 7 19:24:12 localhost lookupd[2187: ONSAgont: dnz_fodn_gquery_scrver - query v
| foiled for 200.240.5.2

Mow 7 19:24:12 localhost last mezsoge repeatad 2 times
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Um exemplo de AppleScript para trocar
o disco de partida do Mac OS 9 para o
Mac OS X:

tell application "Startup Disk”
activate
set startup systern folder alias to alias

5 Bootk”

quit
end tell I
tell application “Finder”
restart
end tell

A variavel [dizzo05%] deve ser trocada pelo
nome do disco onde esta o instalado o
seu Mac OS X.

J

~

¢ Toque DVDna vy

Muita gente reclamou da impossibilidade
de tocar DVDs diretamente para a TV

no Mac OS X
rodando em
portateis.
Mas existe
um truque
para burlar
esse proble-
ma, enquanto
a Apple nao
oferece uma
solucao
definitiva:

{ Conecte o PowerBook a TV. ;

2 Restarte o computador e

feche a tampa.

J Veja o Mac OS X aparecer na TV. A tela
do PowerBook devera estar desligada.

4 Depois que o Mac iniciar, abra nova-
mente a tampa e abra o DVD Player.

& Quando a sessdo de cinema acabar,
coloque o PowerBook para dormir, des-
conecte a TV e acorde o portatil.

-

' B

( Vi — ,
O usuario root (também conhecido como super-usudrio) é o Unico que tem poder absoluto
para fazer o que quiser no computador. Normalmente, trabalhar como root é desne-
cessario, porque o dono do computador tem o status de administrador, que nao é tao
poderoso como o root mas pode instalar programas e updates, mudar as preferéncias do
sistema e fazer outras tarefas. Os outros usuarios nao possuem esse privilégio por
default. Mas, presumindo que vocé conhece algo de Unix e que pretende mexer com pro-
gramacao (ta bom, ou simplesmente hackear a maquina), pode querer habilitar a senha do
root. E o seguinte:

1 Abra o Netinfo Manager (‘&pplications/Utilities/Metinfo Manager).

2 Va ao menu Domain » Security » Authenticate e dé sua senha normal.

J Va 1a uma segunda vez e selecione Enable Root User. O programa pedira a senha duas
vezes e pronto.

Ndo faca o seu trabalho do dia-a-dia como root, pois além de correr o risco de escangalhar
0 sistema por acidente, ndo podera abrir como usuario comum os arquivos que criar como
root.

Na maioria das situacdes, vocé usara a identidade de root s6 na linha de comando.
Existem dois comandos para isso:

ez11 muda temporariamente a sua identidade para a de outro usuario. Se vocé nao digitar
nenhum nome de usudrio apos o =1, 0 sistema assume que vocé quer virar o root. Digite a
senha de root; o
prompt mudara de
acordo. Quando ter-
minar de fazer o que
precisa, digite exit
para coltar a sua iden-
tidade normal.

esudo seguido de um
comando qualquer
executa esse coman-
do sob a identidade
de root.

O sistema da uma
mensagem avisando
da possivel besteira
que vocé ira fazer,
pede a senha e segue
em frente.

® O © Terminal — /Users/marioav/bin/bash (ttypl) 80x25

~N

J

¢Atalhos no-Dock—3

*Colocar um item novo no Dock é muito facil. Apenas arraste o icone até o Dock.

*Para remové-lo, o processo é inverso; é sé arrastar para fora do Dock (e ficar encantado
com o efeito “fumacinha”).

*Para manter um icone de programa no Dock depois de fechado, clique e segure (ou

Show In Finder
Quit
h &

*O mesmo menu serve para localizar
o item no disco e dar Quit em pro-
gramas sem ser preciso ir a eles.
*eTambém da para colocar e tirar ata-
Ihos na barra de ferramentas das
janelas do Finder pelo método de
arrastar e soltar.
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€ Cassic, nunca mais )

®Esta é para os radicais que ndao querem
carregar nunca mais o ambiente Classic.

Mova o arquivo /System/Library/
CoreServices/Classic Startupapp

para um outro local. Via Terminal,

o comando é my ‘/Systern/Library’
CoreServices/Classic Startupapp’

Ylonde woc quiser]/Classic Startupapp’
(Tem um espaco entre o primeiro
endereco e o segundo.)

® Qutra maneira simples de “quebrar’ o
Classic e impedir que ele inicie é sumir
com os arquivos /3ystern Folder/Classic
Support e ASystern Folder/Classic Support UL
Ao abrir-se o Classic, ele ira perguntar se
vocé quer “instalar arquivos que faltam”.
Responda “nao” e siga em frente, livre do
passado. (Obs.: estas dicas ndo tém volta.)

J
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€ OSXaindanio )

Esta é para os que compraram Macs com
0 OS X pré-instalado e nao pretendem
usa-lo, deixando apenas o sistema classi-
co. Dé boot pelo Mac OS 9 e delete os
seguintes itens: Applications, Desktop,
Library, rach, machsym, Systern, Termporaty
Iterns (caso apareca) e Uszers (ndo tem
nada seu la dentro, certo?). A seguir,
abra o ResEdit (download em http://#
download.info.apple.comsdpple _Support_Areas
Apple_Sof tware_pdates/English-North_
americansMacintosh/Utilities/ResEdit _2.1.3.
zeabin) e use o comando File » Get
File/Folder Info para localizar e desligar
a opcao de “invisivel” de cada um dos

ponto (.),
autornount, bin,

seguintes itens:
tudo o que ﬁ

comeca com
] —

cores, dev, eto,
mach_kernel,
private, sbin, tmp,
ust e war. Por fim,
delete-os. Ufa!
Seria mais facil
reformatar o HD e instalar s6 o OS 9.

J
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€ Tecle em portugués )

Vocé usa o teclado americano e ainda
tem que digitar (Option(e)+(e) para escrever
“é”? Saia dessa vida baixando o layout de
teclado US-International, criado por
Rainer Brockerhoff e disponivel na secao
Giftware do site da Macmania

(wwhw macmania.com.br).

(

€ Trocando de sistema )

Se vocé instalou o Mac OS X numa particao diferente da que contém o OS 9,
ja sabe que basta segurar no startup para mudar de sistema. SO que,
nos computadores que apresentam o botdes de opgdes de sistema de partida
(abaixo), o reloginho fica girando uma eternidade até permitir escolher entre
os discos. Experimente segurar o botdo do mouse para acelerar o processo. O Unico
inconveniente é que, se houver algum CD ou outro disco removivel, ele sera ejetado.

Vocé pode evitar problemas com o Classic e aliviar o sistema criando um set (conjunto) de
extensoes reduzido, desativando as extensdes redundantes ou sem funcdo. Para isso, va
ao velho painel de controle Extensions Manager (pelo menu da maca do OS 9, acessivel a
partir de qualquer aplicativo rodando no Classic) e escolha Mac OS Base (Mac OS Basico). A
partir dai, veja o que é que vocé

nao usa mais e desligue também. LLALLLT =i
Se preferir, pode usar o Location M set @
Manager ou o Conflict Catcher B ncuzidn | sieofversin  [recuom  [rype [oreatefs
(da Casady & Greene). i E PR e = =
Recomenda-se criar um set super- || [#E & system fatser 748 - = = =

. w 1 B shutdowns items ok = - - -
leve para o modo Classic e outro I &R Stariun 1tvms F = e
mais completo para quando der 2
partida no Mac pelo OS 9. Os [(Anstart| ((Revert

Hide 1lwm |nfer malion
velhos atalhos de startup do Mac s o bR

OS classico (segurar a barra de

espaco para abrir o Extensions Ki:
ze:
Manager, por exemplo) funcio- (e -

Where.

nam no Classic.

[

Y B
€ Funcoes na barra de menu )

*Algumas funcdes Uteis podem ser adicionadas a barra de menu do Mac OS X. Quando
estiver no System Preferences, veja se a funcdo tem uma opg¢ao Show in Menu Bar.

*QOs itens que podem ficar na barra de menu sao: indicador de sinal do AirPort, indicador
de bateria dos portateis, relégio, controle de resolucao do monitor, transmissor infraver-
melho (IrDA), conexao PPP, PPPoE e volume do som.

*Para retirar, basta arrastar qualquer icone desses para fora do menu com a tecla
apertada, que ele some.

*Da para mudar a ordem de um icone em relacao aos outros. Com a tecla & apertada,
pegue-o e arraste-o até a posicao desejada.

(=1 (101% Wed 2:02:05 ™ ) @




Se vocé é chegado em automatizar tare-
fas, baixe ja o AppleScript Menu (.
apple.comndapplescript/macosx/seript _menus).
Ele coloca um icone para rodar scripts
diretamente na barra de menu. Depois
de baixar o pacote, basta arrastar o
icone para a barra de menus e esta
pronto! Ele de cara ira mostrar os scripts
pré-instalados no sistema, que ja dao
uma idéia do poder injusta e frequente-
mente ignorado do AppleScript.

EA™ <0 quiisoeis
A Banicy »
(3 Finder Scripts .
¥ FantSync Scripts. L
i Info Seripts .
¥ Internet Services. >
A Mail Scripts >
Mew Applications Window
New Documents Window i Script Editor Seripts. »
N | Sherleck Scripes *
Mew Home Window i ukLs >
¥ Open Special Folder
& Browser

—
% Hide Application Windows

& Set View Options
& Tandem
% Tile Finder Windows

Open Scripts Falder

\_

¢ Destrancando o arquivo )

O Recent Servers do OS X lembra as
maquinas acessadas na rede, mas nao
os HDs dentro delas. E preciso passar
por trés janelas sucessivas (Connect,
nome e senha e selecao dos volumes na
maquina remota). Para facilitar, abra a
pasta Favorites (atalho: no
Finder) e ponha la os aliases (atalhos)
dos HDs remotos acessados. Assim, com
dois cliques vocé ja acessa todo mundo.

J
\

J
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€ Quantas conexées tenho? )

eeo Network o
T g [ ( Wy
w Gy - ey B
Shiwe All Date & Time  Displays Screen Saver Dock Sound  Network — Startop Disk Classic
Location: _' Bookmakers ﬂ
Show: _' Active Network Ports ﬂ
Active Ports
Check available port configurations in the list below to activate them.
Al checked are active 1l ¥. Urag ports in the
list 1o specify the order 1o iy them when connecting 10 a netwaork.

on | Por Configurarions
£  Internal Madem
E Built-in Ethernet

 New.. )
E Duplicate \

Delate. ..

alnl

Turn oft any port you no longer want to use in this location by unchecking it.

To change the name of a port configuration, double-ick it
To create multiple configurations of a pert, use the New or Duplicate button,
To delete 2 porr configurarion, select it and press Dalete.

@ Click the lock to prevent further changes. " Apply Now

Se vocé se conecta a Internet apenas pelo modem ou apenas pela rede (Ethernet), para evi-
tar que o Mac OS X fique pegando a conexao errada de bobeira, va ao System Preferences,

médulo Network (Re-
de), e no menu pop-
up Show (Mostrar)
escolha a opcao
Active Network Ports
(Portas de Rede
Ativas). Desative as
portas que vocé nao
vai usar; em seguida,
use 0 mesmo menu
pop-up para retornar
a janela normal de
configuracao.

~
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[ Apple

*No Mac OS X 10.1 é possivel aumentar ou diminuir a largura de uma coluna na janela
do Finder. Arraste o botdozinho que fica na base de cada coluna para ajustar todas ao
mesmo tempo. Para arrumar uma coluna s6 por vez, arraste o botdo respectivo com a
tecla (Option) apertada.
*Um beneficio de alargar colunas é que os movies QuickTime e algumas imagens
podem ser vistos em tamanhos bem maiores do que o de um icone.

& Apple Retal...ores 2.mov

28 items, 892,3 ME available

Apple VR >
[ Apple Clissicos 2 *
| concert_long_T1.mov

u Cube >
[Jcaereca "
e "
[0 HAL "
[F iBook ¢ AirPort "
:2 ibook_int_T1.mov

1 ibook_mid...seat_T1.mov
1 ibook_universe_T1.mov

u iMac >

[ iMac - Kihei "

Name: concert_long_T1l.mov
Kind: Document

Size: 20,7 MB

Created: 17.05.01
Modified: 17.05.01
Dimensions: 480 =x 360
Duration: 01'48

J




E possivel editar & mio as preferéncias do sistema para alterar o
tipo default de imagem criado quando se tira uma captura da
tela com @)(ShifY(3). Abra o Terminal e digite:

defaults write MSGlobalDormain AppleScreenShotFormat [formata]

ca de dar logout e login para as mudancas terem efeito.

\.

[formata] pode ser JPEG, PMNG ou PICT (TIFF é o padrdo). Ndo esque-

N
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*Se vocé for a janela About this Mac (a primeira coisa no menu

da maca) e clicar bem aonde esta o niimero da versao (“Version
10.17), ele muda para o build da versao instalada.

*Dando outro clique em seguida, ele mostra o nimero de série
da sua maquina.

*Esse € um meio rapido de saber se o seu Mac esta com a ulti-

ma atualiza¢do do sistema. O Mac OS X 10.1 original é o build

G64. Apos o update de seguranca lancado pela Apple em 19 de
novembro, ele virou 5L21. IV}

©® O O About This Mac ©® O O About This Mac ©® O O About This Mac
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